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Conéctate con usuarios de todo el mundo y aprende mas sobre Notion

Notion es parte de PreSonus - conéctate con nosotros a través de www.presonus.com y mira todos los productos
de los que formamos parte en www.presonus.com

Expande tu libreria de sonidos — visita http://shop.presonus.com/products/software para increibles sonidos de
expansion

Foro de Miisica Notion — Unete a las discusiones sobre una enorme variedad de temas, desde consejos para usar los
productos de Notion Music hasta noticias sobre tecnologia musical en hardware y software.

Portales sociales de Notion — jUnete a nosotros en linea a través de Facebook o Twitter!
http://blog.presonus.com

http://forums.presonus.com

http://www.facebook.com/Notionmusic

http://www.twitter.com/Notionmusic

Soporte

Lee el Manual del usuario en PDF, mira nuestro canal de YouTube, pidele ayuda a tus colegas en el foro o envia una
solicitud de soporte desde la liga que se encuentra en la Base de Conocimientos o directamente desde tu perfil My.
PreSonus. También hay recursos disponibles de otras fuentes, como la serie tutorial de Notion en Groove3.com y el libro
Create Music with Notion, ambos de George Hess.

Base de Conocimiento — http://support.presonus.com

Foros - http://forums.presonus.com

Crea una solicitud de soporte técnico - ya sea desde tu perfil en
http://my.presonus.com, o a través de http://support.presonus.com

Como bajar software

Para recibir tu software, registrate en linea en my.presonus.com con la llave de producto proveida. Las ligas para hajar el
software y los sonidos se afiadirdn a tu perfil una vez que hayas oprimido “Register New Software” e introducido la llave
de producto. También encontrards el manual completo de Notion y las Guias de Referencia Rdpida se habran afadido a tu
perfil para tu referencia.

Instalacion

Haz doble clicken el software Notion que bajaste y sigue las instrucciones de la pantalla. Durante la instalacion, puedes
escoger tu idiomay si quieres instalar el software a 32 6 64 bits.

Activacion

Después de completar la instalacion, puedes elegir la activacién de tu copia de Notion o bien usar el programa en modo
de Demo, pero no podrds imprimir, guardar o exportar tu trabajo hasta no activar el software. Para activarlo, ingresa la
llave de producto y tu direccion de correo electrénico. Una vez completado este proceso, podrds empezar a trabajar con
Notion.



http://shop.presonus.com/products/software
http://blog.presonus.com
http://forums.presonus.com
http://www.facebook.com/Notionmusic
http://www.twitter.com/Notionmusic
http://support.presonus.com
http://forums.presonus.com
http://my.presonus.com
http://support.presonus.com
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Notion para i0S es un excelente companero
para tu nuevo software Notion.

Cuando usas Notion en tu computadora y iPad o iPhone puedes
compartir tus archivos de manera perfectamente integrada con iCloud y
Dropbox. Es una excelente manera de sequir trabajando en tus proyectos
cuando estas en movimiento. Puedes editar y reproducir tu partitura en
una plataforma y después enviarla a la otra y sequir trabajando en el
mismo archivo.

http://www.presonus.com o busca Notion en la App Store

Obtén lo mejor de dos mundos con
StudioOne de Presonus

Notion6 introduce transferencia de informacion perfectamente
integrada con la galardonada estacién de trabajo de audio digital Studio
One de Presonus. Ahora puedes compartir audio, informacion de
notacion y documentos en ambas direcciones, entre Studio One y
Notion, estén en la misma computadora o corriendo en cualquier lugar
de la red.

Prueba el demo gratuito de Studio One — disponible en tu perfil
my.presonus.com



La ventana principal de Notion

Pasards la mayor parte de tu tiempo en la ventana principal de Notion, donde encontrards muchos controles convenientes,
paletas e indicadores; he aqui algunos:

NTempo. Controla la reproduccion de tu partitura
con NTempo seleccionando este icono.
Transporte. Accede a los controles de
reproduccion y grabacion.

Nombre del Instrumento. Muestra el
nombre del instrumento por pentagrama.

Area de la partitura. Area grande con tu n
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La Barra de Herramientas

Los iconos localizados en la barra de herramientas le permiten al usuario un acceso facil a las herramientas usadas
frecuentemente.

A - Insercién a mano. Inserta notas directamente en el Area de la Partitura o activa el drea opcional de insercién a
mano con aumento (zoom).

B - Teclado Virtual. Inserta notas y acordes o prueba una melodia con este teclado interactivo.

C - PadVirtual de Bateria. Inserta el tambor o nota deseada mientras estés en el modo de insercion por pasos de
tiempo (step time).

D - Diapason Virtual. Inserta notas y acordes o prueba una melodia con el diapasén virtual.

E - Libreria de Acordes. Selecciona, crea e inserta acordes o diagramas de acorde en tu partitura.

F - Preparacion de Partitura. Has clicken este boton para que puedas afadir, cambiar, editar o quitar, ripidamente,
un pentagrama en tu partitura.

G - Mezcladora. Has clicken este boton para abrir la consola mezcladora de audio para que puedas ajustar audio de
instrumentos individuales, editar efectos, enviar salidas a equipo externo y més.




Guitarra, Bajo y Otros Instrumentos con Trastes

;Prefieres trabajar en tablatura? Notion te tiene cubierto. Trabaja con tablatura, oYe @ o
un diapason virtual y una hiblioteca interactiva d acordes para capturar tus ideas .
més nuevas. Swing
Inserta técnicas cominmente usadas como bends, slides, hammer-ons, o ¥R éi
pull-offs, taps, slaps, vibratos y arménicos. lome— == =
Las ediciones que hagas en tablatura aparecen en un pentagrama de r " \f r
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Con las opciones que aparecen en la Paleta de Insercion puedes acceder rapidamente a las indicaciones que puedes
colocar en tu partitura. Esta paleta automdticamente aparecerd en la parte inferior del drea de la partitura, pero puedes
programarla para que aparezca al hacer un right click siempre que tu cursor esté en la partitura (Ir a Ventana>Mostrar

Paleta).

Trata de Insertar una Indicacion en la Partitura
Simplemente coloca tu mouse sobre uno de los paneles inferiores para abrir una ventana temporal con opciones.
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Coloca tu cursor sobre cualquiera de las opciones para ver mas informacion en un
tooltip. Para usar una indicacién en especial, haz click sobre ésta.

Un representacion de este simbolo ahora aparece en tu cursor (un Cursor Musical)
Coloca la indicacion donde la quieras (ver a la izquierda). Para anadirsela ala
partitura, haz click en tu mouse u oprime ENTER. Es asi de facil.



Preparacion de la partitura

Haz clicken el botdn , para hacer visible esta funcién. En Score Setup puedes afiadir, cambiar o eliminar
pentagramas. También puedes esconder/hacer visible, personalizar el orden, cambiar la apariencia y cambiar los
instrumentos asignados a mdltiples pentagramas.

Score settings - accede a las opciones de ajuste del

a
pentagrama. T Y
Remove instrument - elimina el instrumento del . L % i# € f
pentagrama. ki
fo

Hide/Show instrument - esconde/hace visible el

instrumento en tu pentagrama. 'ﬁ' ® e %iﬁ ¢ #ﬂ
f

Notion Instruments : (Cambia de instrumento, nombre de la parte o abreviacién.
Saxophones o Bass Flute
Guitars/Basses. » Flute Duo
Keyboards/Harp » Oboe
Drums/Cymbals. » Oboe Duo
s Prcuson * | Groncthmae
Sound Effects » Bass Oboe
Special » Clarinet Section

Clarinet Duo

Bass Clarinet
Contrabass Clarinet
Basset Horn
Bassoon

Part name: | Flutes

Abbreviation: | Fl. & FI ]

Plug-in Manager... [ cancel | [Frok ]

Cambia de ajuste de instrumento y ajustes de notacion. nstrument
Staff:
Show Standard Notation Grand Staff (piano)
Show Tablature Drum Set
© show Both Single-line Staff

Sequencer Staff

Tab tuning: | E2 A2 D3 G3 B3 E4

Voice Stem Mode:

Separate up/down

Transposition:
Notated C sounds:

c One octave Lower K

<]

Transpose chord symbols

Plug-in Manager... Cancel




Trata de anadir un Pentagrama o Instrumento

Parte del proceso de afiadir un nuevo pentagrama es asignarle un instrumento, trabajando de abajo para arriba
(las letras se refieren a las indicaciones de la ilustracién):
1 Haz click en una fuente sonora, como por ejemplo, uno de los instrumentos Notion incluidos.
2 Coloca tu cursor sobre una familia de instrumentos.
Aparecerd un sub-mend de instrumentos.
Haz click en un instrumento.
3 » Acabas de crear un nuevo pentagrama y le has asignado un instrumento.
Puedes seguir creando més pentagramas rapidamente de esta manera. Para salir de Organizacion de Partitura (Score
Setup), puedes oprimir el botdn Exit Score Setup que estd en la parte superior u oprimir ESC.

»

Instrumentos — Haz clicken el > e
instrumento que quieres asignar. | [ext score sews |
Familias de Instrumentos — Las

opciones cgmblan con |a fuente sonora que e e
selecciones abajo. Vilin 1 (secton) Vila (s90)
. . z . . Viola (section) Cello (solo)
Opciones de libreria — Mira las opciones i el
que estdn instaladas actualmente en tu Doubl-bess (sectior)
computadora.

Puedes bajar instrumentos adicionales, efectos de
sonido y técnicas de interpretacion. Prueba los
Sonidos de Expansion en:
http://shop.presonus.com/products/software

i

Notion Instruments



http://shop.presonus.com/products/software

Area de la Partitura

Instrumentos ilimitados, paginas ilimitadas y altamente personalizables.
Trabaja en una partitura completa o sélo con tu seleccion de instrumentos — o edita o imprime rapidamente un solo
instrumento (ve a la barra de Mend y selecciona Score > Dynamic Parts).

Vista Continua de Pagina — Notion ofrece tres vistas 'BS: ||
de pdgina. La que se muestra aqui es Continua. Esta vEEe =t J Jj f =
opcion de “transporte no-manual” incluye una reproduccién de Ben. I A
la partitura sin cortes por pagina. : =
o it s vistsde g y B = Na e A
Para cambiar las vistas de pagina, ve a la barra de Mend y ¢ e
selecciona View. e P ||
Las tres opciones en la parte superior del ment son = =i = ]
Continuous, Pages Across,y Pages Down.
Margin —Visible en la opcién de Continuous View, esta P i .
ventana te actualiza sobre la Tonalidad y Métrica actuales, | P9— t !
e identifica a los instrumentos en texto color rojo. Vi
Marcador de reproduccién - Visible en todas las ¢ iE 2 o ey
vistas de pdgina, este marcador verde que abarca todo el E mf
pentagrama identifica dénde estd la reproduccidn en ese Vins.
momento. Conforme se mueve hacia la derecha el marcador, tu @ W —E = =57 v hly =
vista de la partitura salta hacia adelante automdaticamente. I I mf
Vlas.
Bre |- @ EREE
Vs, mf
Cb mf
Fyre | drr Dk D
K Text # b Jy = =




Mezcladora ) £ Gutar
Funciopa con una consola de harfiware, iperosin la NeeTar A
molestia de los cables! Hay una tira de canal para cada v
instrumento, ocho buses y una tira de canal maestro. =k
Haz clicken el boton de Mezcladora en la barra de
herramientas para abrir esta ventana separada.
Estos botones de familias de instrumentos te
ayudan a encontrar rdpidamente las tiras de canal
que quieres.
Sends — Envia un porcentaje del sonido de una
tira de canal a uno o mds buses.
c Power Panning — No sélo es simplemente la
colocacién lzq./Der., sino que también, qué tan Strings
amplia es la separacion.
Output — Haz click para determinar a donde se Perc
envia el sonido de esta tira: al canal Maestro 0 a
canales digitales externos.
Inserts — Aiddele efectos como (como reverb o
distorsion) a instrumentos individuales o (atin
mejor) en uno o més buses que se pueden compartir
entre tu seleccion de instrumentos.

Solo/Mute — Excelente para aislar puntos
problematicos mientras compones o durante
ensayos. Prepara instrumentos multiples en solo o mute

con s6lo unos clicks.
@ Master — Volumen, paneo y efectos globales.

D E. Guitar Master
l__ Output Output




Heads-Up Display — Esta ventana opcional (disponible

cuando estas en modo NTempo) te mantiene al tanto sobre

las condiciones actuales de reproduccién.

- En este ejemplo:

A —Llaindicacién actual de ensayo.

+ 1/4 — El marcador de reproduccién esta en el tiempo 1
de un compds de cuatro compases.

+ 15— El marcador de reproduccion estd en el compds 15.

+ 130 130 — El primer nimero més pequefio identifica el
tempo escrito. El sequndo nimero més grande identifica
tu tempo actual.

« Elc6digo de tiempo de la parte inferior se muestra en
horas:minutos:segundos:cuadros (30 cuadros/segundo).
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Instrumentos virtuales

Los instrumentos virtuales te permiten insertar o escuchar notas/acordes seleccionando una duracién y haciendo clicken
la nota del instrumento ya sea para escuchar o para insertar la nota.

m Escoge si quieres insertar musica como notas individuales (melodias) o notas multiples (acordes).
IE Escoge el icono de Iapiz para insertar notas conforme las seleccionas en el instrumento virtual.

Selecciona el icono de bocina para escuchar notas con los instrumentos virtuales.

D] Selecciona la octava que en la que te gustaria insertar/escuchar notas (sélo teclado virtual).

Funk 1 Funk 8ths 4
Funk 2 Funk 16ths 1
Funk 3 Funk 16ths 2
Funk 4 Funk 16ths 3
Funk 8ths 1 Funk 16ths 4
Funk 8ths 2

Funk 8ths 3

El pad'virtual de bateria funciona exactamente igual que el resto de los instrumentos virtuales, con la adicion de la libreria
de bateria. Para usar la libreria de bateria selecciona un estilo (funk, jazz, rock, o world), escoje un patrén y haz clicken la
partitura para seleccionarlo.

NTempo o Edit Mode — Notion opera ya sea en Modo de Edicién, donde puedes hacer cambios, en Modo NTempo,
donde las prestaciones de edicion estdn apagadas y ciertas caracteristicas de reproduccién se hacen disponibles. Para
cambiar de modos, haz click en el botén NTempo.
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Transporte
Botones opcionales para tareas comunes.

Regresar — Haz clickuna vez para regresar al punto en donde empezaste la tltima vez. Haz click dos veces para regresar
al principio.

D Detener — Detiene la reproduccion pero permanece en esa ubicacion.

D Reproducir — Haz que Notion reproduzca tu partitura usando marcas de metronomo en tu partitura para
determinar el tempo.

O Grabacion en tiempo real — Haz click para que Notion grabe notacion conforme tocas un dispositivo MIDI.

ﬂ Grabacion por pasos de tiempo — Haz click para ingresar informacion o notacion con un dispositivo MIDI
un paso a la vez. También se puede usar con el diapasn virtual.

Sobregrabacion por Tempo — Usando la prestacién NTempo, especifica y edita el tempo, hasta por tiempos
individuales. Se puede usar para reducir el nimero de indicaciones de metrénomo en una partitura.

Metronomo — Escoge si quieres que el metronomo se escuche durante la reproduccion.

Barra de herramientas — Tira delgada con varios controles

ubicada a lo largo de la parte superior de la ventana

Marcador de edicion — Muestra, de un vistazo, dénde te "

encuentras actualmente en la partitura. == m /
Consejo de herramientas — ;No estds sequro de qué indica 281 f ~_|r F

un simbolo en particular? Estas pequefias ventanas se abren para wl

decirtelo - y te recuerdan los atajos de teclado. e 5 j =
Personaliza tu vista — Cambia vistas de pagina, cambia el tamafio : 2
del texto 0 cambia a un formato de texto de partitura de jazz, acerca o . . _
aleja (zoom), especifica dénde aparecen los nimeros de compds, salta = I}] ﬂ ﬁ' @ hm =
instantdneamente hacia adelante o hacia atrds, y mds.
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Escritura a mano

Ahora puedes usar tu propia escritura a mano como una herramienta de insercién de notas - ya sea directamente sobre la
partitura o sobre el drea de escritura a mano que aparece. El motor de escritura a mano de Notion estd impulsado por
MyScript™ de Notion, el cual ha analizado miles de diferentes estilos de escritura musical a mano - esto quiere decir que
no hay gestos personalizados que debas aprender a usar, ni que el software tenga que “aprender” a interpretar tu estilo
personal. El reconocimiento esta disponible para pentagramas de notacién estandar, pero no para notacion de percusion o
tablatura.

Aprendiendo a escribir directamente sobre la partitura

Haz click en el icono de escritura a mano. Ahora puedes escribir a mano libremente, directamente sobre el drea
QV de la partitura. Cuando dejas de escribir, Notion esperard unos sequndos y después convertird tu escritura a
mano en notacion digital.
Para mover el drea de partitura: usa ya sea las barras de desplazamiento o, en una Surface de Microsoft o en un Mac
Trackpad, usa dos dedos para mover la partitura como quieras.
Para acercar o alejar la vista de la partitura (zoom), usa ya sea el atajo de teclado (Ctrl/Cmdy + 6 -) o, en una Surface de
Microsoft o en un Mac Trackpad usa dos dedos y sepdralos para acercar.

Como escribir sobre el area de escritura a mano

Haz click sobre el icono de la herramienta de escritura. Aparecerd el icono de “lupa”. Haz clicken éste
para mostrar/esconder el drea de escritura a mano que esté en la parte inferior de la pantalla. Esta
opcién para escribir es especialmente dtil para: escribir sobre partituras grandes y no tener que estar
acercando 0 alejando tu vista (zoom); combinar la escritura a mano con otros métodos de insercion de notas, como
grabacién con MIDI o por pasos de tiempo.

Haz clicken un compéds del drea principal de partitura y el drea de escritura a mano saltaréd a ese punto. Ahora puedes
empezar a dibujar. Cuando termines de dibujar, Notion esperard un par de sequndos y después convertird tu escritura a
mano en notacién digital.

Dibujar
Notion puede convertir notas, silencios, acordes, articulaciones, barras de compds, alteraciones, métricas, lineas
adicionales, ligaduras de duracién y fraseo y claves.

Voces

J el b Para escribir en diferentes voces, selecciona qué voz necesitas en la paleta o usa el
Multi-voice: £ e f”ff @ | atajo de teclado Cmd/Ctrl + x (donde x = 1-4).

Eliminar

Puedes tachar para eliminar. Para eliminar una nota, tacha la cabeza de la nota en si. También puedes
seleccionar el simbolo y presionar “delete”.




Presion

En una Surface de Microsoft, el grosor de la linea dibujada responderd a la presion del lapiz sobre la pantalla. Esto da una
sensacién mucho més natural al escribir y mayor precisién en el reconocimiento -aunque tu hermosa escritura a mano
serd, a fin de cuentas, convertida a notacién digital.

iPero no tengo una pantalla tactil!

Lee nuestra Base de Conocimiento para obtener ideas sobre cdmo usar la capacidad de reconocimiento de escritura a
mano sin usar una pantalla tdctil.

Elementos disponibles para conversion de escritura a mano:
Claves: Barras de compas/Repeticiones:

I I H
| 1 | 1l

Duracion de notas: Acordes/Alteraciones:

4?—1—V—F’—'?Jg e e e e

jConsejo! Mantén pequerios los sostenidos al escribir:

Duracion de silencios: Ligaduras de duracion y expresion:

D4
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Dosillos: Articulaciones:
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Métrica: Lineas adicionales:

% A MysScript.
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Interoperabilidad con Studio One

Usa lo mejor de ambos mundos...

Si estds usando una estacion de trabajo de audio digital y software de notacién en tu flujo de trabajo, ya sea por ti mismo
0 en colaboracién entonces tenemos nuevas maneras de transferir tus ideas musicales entre estos dos mundos. ;No tienes
Studio One? Prueba el demo ahora en tu perfil my.presonus.com ...

(omo mandar audio a Studio One
(&) @

~/~ StudioOne

Send to Studio One

Send audio to Studio One, creating a
Send Audio
new session with individual tracks.

Send notes to Studio One, creating
sequencer tracks from notation.

Send Notes

Cancel

;Listo para mandar tus sonidos orquestales a Studio One para mezclar? ;Terminaste de usar ReWire y ahora quieres

terminar el proyecto? Ahora puedes mandar audio directamente a Studio One (versién 3.3 y més reciente) corriendo en la

misma computadora o bien a cualquier instancia abierta de Studio One en cualquier lugar de la red.

Abre Studio One ya sea en la misma maquina o en una maquina en la misma red:

1. En Notion, ve a File>Send to Studio One (6 Cmd/Ctrl + Shift + U)

2. Notion ahora bajaré el audio y lo transferird a Studio One, abriendo un nuevo documento automaticamente.

3. En Studio One, el nuevo documento ya estd listo, completo en el orden correcto de partitura, con nombre de archivo,
nombres de instrumentos, tempo, métrica, indicaciones de ensayo, volumen y paneo de instrumento.

Si quieres mandar un extracto o una idea corta en lugar de toda la partitura, primero haz una seleccion en la partitura

antes de abrir el didlogo de Studio One.

Manda informacion de notas a Studio One

;Concibes tus ideas “pensando en notacion” pero necesitas, al final, usar tu estacién de trabajo de audio digital? Ahora
puedes componer en Notion y después mandar informacion de notas (MIDI y otra informacién relacionada con notas)
directamente a Studio One (versién 3.3 y més reciente) corriendo en la misma computadora o bien a cualquier instancia
abierta de Studio One en cualquier lugar de la red.

Abre Studio One ya sea en la misma maquina o en una maquina en la misma red.

4. En Notion, ve a File>Send to Studio One (6 Cmd/Ctrl + Shift + U)

5. Notion ahora bajara el audio y lo transferird a Studio One, abriendo un nuevo documento automaticamente.

6. En Studio One, el nuevo documento ya estd listo, en el orden correcto de partitura, para que les asignes los sonidos.
Ademds de afinacion y duracién, Notion también envia nombre de archivo, nombres de instrumentos, tempo, métrica,
indicaciones de ensayo.

Si quieres mandar un extracto o una idea corta en lugar de toda la partitura, primero haz una seleccién en la partitura

antes de abrir el didlogo de Studio One.



http://my.presonus.com

Si estds usando un instrumento VST de otra compaiiia en Notion, como Vienna Symphonic Library, la informacién de
programa también se envia y el VST se carga autométicamente en Studio One, jlo cual es excelente!

Envia a Notion desde Studio One

Send to Notion

ion

Notion on: This computer

@ Send note data of entire song
Send note data of selected tracks
Send audio mixdown

Send audio stems

You can also send audio files to Notion from the file browser.

Send Cancel

iEsta relacion es reciproca! Con Studio One version 3.3 y mds reciente, ahora puedes Enviar a Notion (“Send to Notion”).
Escoge si quieres mandar informacién de audio o de notas, ya sea de pistas seleccionadas o del archivo completo.
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